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01 | Τι είναι το Analysis ToolPak;
Ορισμός & Βασικά Χαρακτηριστικά
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Ορισμός

Το Analysis ToolPak είναι ένα δωρεάν πρόσθετο (Add-in) του Microsoft Excel 
που παρέχει εξελιγμένα εργαλεία στατιστικής, χρηματοοικονομικής και 
μηχανικής ανάλυσης — χωρίς να χρειάζεται προγραμματισμός ή εξωτερικό 
λογισμικό.

Περιέχει 19 εργαλεία ανάλυσης, από τα οποία οι πιο σημαντικές για τον κλάδο μας 
είναι:

Descriptive Statistics Histogram Regression

Correlation / 
Covariance

t-Test (3 τύποι) ANOVA (3 τύποι)

F-Test Moving Average Sampling & Fourier

Γιατί το χρειάζεστε στη Ναυτιλία: Ανάλυση φορτίων, πρόβλεψη εσόδων λιμένα, 
σύγκριση απόδοσης πλοίων, έλεγχος ποιότητας υπηρεσιών.



02 | Εγκατάσταση Analysis ToolPak — Windows
Βασισμένο στο Lab 4: Data Analysis in Excel
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1
Αρχείο (File) → Επιλογές (Options)

Κλικ στο πράσινο μενού "File" → επιλογή "Options"

2
Κατηγορία Add-ins

Στο παράθυρο Excel Options, αριστερά επιλέξτε "Add-ins"

3
Manage → "Excel Add-ins" → Go

Κάτω από τη λίστα, βεβαιωθείτε ότι είναι επιλεγμένο "Excel Add-ins" και κλικ "Go..."

4
Τσεκάρετε Analysis ToolPak

Στο παράθυρο Add-Ins, βάλτε ✓ στο "Analysis ToolPak" (και προαιρετικά "Analysis ToolPak -
VBA")

5
OK → Επαλήθευση

Κλικ ΟΚ. Η επιλογή "Data Analysis" εμφανίζεται στην καρτέλα "Data" (Δεδομένα) → ομάδα 
"Analysis"

Επαλήθευση

Μετά την εγκατάσταση:

1. Καρτέλα «Δεδομένα»

2. Δεξιά πλευρά κορδέλας

3. Ομάδα «Ανάλυση»

4. Κουμπί «Ανάλυση Δεδομένων»

Για Mac:

Εργαλεία (Tools) → "Excel Add-Ins..." → ✓
Analysis ToolPak → OK
(Απαιτεί Excel 2019+ ή Microsoft 365)



03 | Βασικές Λειτουργίες — Επισκόπηση
Τα 7 πιο χρήσιμα εργαλεία για τον κλάδο σας
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Descriptive Statistics

Μέσος, διάμεσος, τυπική απόκλιση, κυρτότητα κ.ά.

Histogram

Κατανομή συχνοτήτων δεδομένων σε κλάσεις

Regression

Πρόβλεψη & εξήγηση εξαρτημένης μεταβλητής

Correlation

Βαθμός γραμμικής σχέσης μεταξύ μεταβλητών

ANOVA

Σύγκριση μέσων 3+ ομάδων ταυτόχρονα

F-Test & t-Test

Σύγκριση μέσων & διακυμάνσεων 2 ομάδων

Moving Average

Εξομάλυνση χρονοσειρών & πρόβλεψη τάσεων



04 | Ιστόγραμμα (Histogram) — Παράδειγμα από Lab
Κατανομή βαθμών φοιτητών χρησιμοποιώντας TTU scale
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1 Εισαγάγετε τα δεδομένα (βαθμοί φοιτητών) σε στήλη Α

2 Εισαγάγετε τα bin numbers (TTU scale: 59, 66, 69, 72...) σε στήλη Β

3 Δεδομένα (Data) → Ανάλυση Δεδομένων → Histogram → ΟΚ

4 Input Range: Επιλέξτε στήλη βαθμών (π.χ. $A$2:$A$15)

5 Bin Range: Επιλέξτε στήλη TTU scale (π.χ. $B$2:$B$13)

6 Output Range: Επιλέξτε κελί εξόδου

7 ✓ Chart Output → ΟΚ

Αποτέλεσμα — Πίνακας Συχνοτήτων

Bin Frequency

59 8

66 3

69 0

72 0

76 4

79 6

82 2

86 8

89 14

92 11

96 2

100 5

More 0

Ερμηνεία: Οι περισσότεροι βαθμοί (14+11=25) 
συγκεντρώνονται στις κλάσεις 86–92, με αρνητική ασυμμετρία 
(skewness = -1.62). Κατανομή μετατοπισμένη προς τις υψηλές 
τιμές.



05 | Περιγραφική Στατιστική — Παράδειγμα από Lab
Ανάλυση βαθμών 63 φοιτητών
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1 Δεδομένα → Ανάλυση Δεδομένων → "Descriptive Statistics" → ΟΚ

2 Input Range: Επιλέξτε στήλη βαθμών ($A$2:$A$15)

3 Grouped By: Columns

4 Output Range: Επιλέξτε κελί εξόδου (π.χ. $C$1)

5 ✓ Summary statistics → ΟΚ

Αποτελέσματα (από Lab PDF)

Στατιστικό Μέτρο Τιμή

Mean (Μέσος) 80.21

Standard Error 2.05

Median (Διάμεσος) 87

Mode (Επικρατούσα) 89

Standard Deviation 16.27

Sample Variance 264.62

Kurtosis (Κυρτότητα) 1.91

Skewness (Ασυμμετρία) -1.62

Range (Εύρος) 67

Minimum 31

Maximum 98

Sum (Άθροισμα) 5053

Count (Πλήθος) 63

Ερμηνεία Αποτελεσμάτων:

Skewness = -1.62 → αρνητική ασυμμετρία (οι βαθμοί τείνουν προς τις υψηλές τιμές). 
Kurtosis = 1.91 → λεπτόκυρτη κατανομή. Ο μέσος (80.21) είναι χαμηλότερος από τη 
διάμεσο (87), επιβεβαιώνοντας την ασυμμετρία.



06α | ANOVA Single Factor — Παράδειγμα από Lab
Σύγκριση κερδών εταιρείας μεταξύ 9 περιοχών (G1–G9)
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Σενάριο: Εταιρεία με δεδομένα κερδών (2009–2014) σε 9 γεωγραφικές περιοχές (G1–G9). Ερώτηση: Υπάρχει στατιστικά σημαντική διαφορά 
μεταξύ των περιοχών;

Υποθέσεις:

H₀: MG1 ≈ MG2 ≈ ... ≈ MG9  (δεν υπάρχει διαφορά)
H₁: Τουλάχιστον ένας μέσος διαφέρει

1 Δεδομένα → Ανάλυση → ANOVA: Single Factor

2 Input Range: $A$5:$G$13, Grouped By: Rows

3 Labels in first column: ✓, Alpha: 0.05

4 Output Range: επιλέξτε κελί → ΟΚ

Αποτέλεσμα ANOVA (από Lab)

Source SS df F P-
value

F crit

Between 13,805,553 8 0.42
1

0.902 2.152

Within 184,179,760 45 — — —

Total 197,985,313 53 — — —Συμπέρασμα:

F (0.421) < F_critical (2.152)  →  ΑΠΟΔΕΧΟΜΑΣΤΕ την H₀
Δεν υπάρχει στατιστικά σημαντική διαφορά κερδών μεταξύ των 9 
περιοχών (p=0.902 >> 0.05).

Αν H₀ απορριπτόταν: ANOVA δεν δείχνει ΠΟΙΕΣ ομάδες διαφέρουν —
χρειάζεται t-Test για κάθε ζεύγος.



06β | ANOVA Two-Factor — Παράδειγμα από Lab
Σύγκριση εκτιμήσεων ρυθμού ανάπτυξης: 5 εταιρείες × 4 εμπειρογνώμονες
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Δεδομένα: Ρυθμός Ανάπτυξης (%)

Εταιρεία Expert 1 Expert 2 Expert 3 Expert 4

C1 8 12 8.5 13

C2 14 10 9 11

C3 11 9 12 10

C4 9 13 10 13

C5 12 10 10 10

Βήματα:

1 Δεδομένα → Ανάλυση → ANOVA: Two-Factor Without Replication

2 Input Range: $A$1:$E$6, ✓ Labels, Alpha: 0.05

3 Output Range: επιλέξτε κελί → ΟΚ

Αποτελέσματα ANOVA

Source F P-value F crit

Rows (εταιρ.) 0.145 0.962 3.259

Columns 
(expert.)

0.481 0.701 3.490

Error — — —

Συμπέρασμα:

F_Rows < F_Rows_Crit  &  F_Columns < F_Columns_Crit
→ Αποδεχόμαστε H₀ για εταιρείες & εμπειρογνώμονες
→ Δεν υπάρχει στατιστικά σημαντική διαφορά.

Two-Factor WITH Replication:

Χρησιμοποιείται όταν έχουμε πολλαπλές παρατηρήσεις ανά 
κελί. Επιτρέπει τον έλεγχο αλληλεπίδρασης (Interaction) 
μεταξύ των δύο παραγόντων.



07 | F-Test & t-Test — Παράδειγμα από Lab
Σύγκριση ωρών μελέτης: Γυναίκες vs Άνδρες φοιτητές
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Δεδομένα: 9 γυναίκες (26,25,43,34,18,52,45,26,29) & 8 άνδρες (19,25,23,30,18,25,23,28) — ώρες μελέτης.

Βήμα 1: F-Test (Έλεγχος Διακύμανσης)

Σκοπός: Ελέγχουμε αν οι διακυμάνσεις (variances) είναι ίσες.
Το Variable 1 πρέπει να έχει μεγαλύτερη διακύμανση!

Data → ANOVA → F-Test Two-Sample for Variances

Γυναίκες Άνδρες

Mean 33.11 23.88

Variance 126.11 16.70

Observations 9 8

F 7.553

P(F≤f) 0.0075

F Critical 3.726

F (7.55) > F_Critical (3.73) → ΑΠΟΡΡΙΠΤΟΥΜΕ H₀ → Διαφορετικές 
διακυμάνσεις!

Βήμα 2: t-Test (Σύγκριση Μέσων)

Επειδή F-Test έδειξε ανισότητα διακυμάνσεων, χρησιμοποιούμε:
t-Test: Two-Sample Assuming UNEQUAL Variances

Var.1 Var.2

Mean 33.11 23.88

df 10

t Stat 2.302

P(T≤t) 2-tail 0.044

t Crit 2-tail 2.228Δίπλευρος έλεγχος: |t Stat| > t Critical → ΑΠΟΡΡΙΠΤΟΥΜΕ H₀

t(2.302) > t_crit(2.228) → Στατιστικά σημαντική διαφορά μεταξύ 
γυναικών & ανδρών!



08
Ναυτιλιακές
Εφαρμογές

Πώς εφαρμόζεται το Analysis ToolPak στη Διαχείριση Λιμένων & Ναυτιλία

Ανάλυση Φορτίου (TEU)

Χρόνοι Παραμονής Πλοίων

Πρόβλεψη Εσόδων Λιμένα

Κατανάλωση Καυσίμων

Εποχικότητα Αφίξεων



08 | Ναυτιλιακές Εφαρμογές Analysis ToolPak
5 Πρακτικά Παραδείγματα από τον Κλάδο
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Ανάλυση Φορτίου Λιμένα (TEU)

Descriptive Statistics

Υπολογισμός μέσης χωρητικότητας, διακύμανσης και εποχικών 
αιχμών σε αριθμό εμπορευματοκιβωτίων (TEU) ανά μήνα.

→ Δεδομένα: Μηνιαίο TEU λιμένα Πειραιά 2020–2024

Σύγκριση Χρόνων Ελλιμενισμού

t-Test / ANOVA

Σύγκριση χρόνων παραμονής πλοίων σε διαφορετικές αποβάθρες ή 
λιμάνια για αξιολόγηση αποτελεσματικότητας.

→ H₀: Ο μέσος χρόνος παραμονής είναι ίδιος σε αποβ. Α και Β

Πρόβλεψη Εσόδων Λιμένα

Regression + Moving Average

Πρόβλεψη μηνιαίων εσόδων λιμένα βάσει TEU, αριθμού πλοίων και 
εποχής. Έλεγχος R² για αξιολόγηση μοντέλου.

→ Y(Έσοδα €) = 50.000 + 185×TEU + 2.100×Πλοία (R²=0.91)

Ανάλυση Κατανάλωσης Καυσίμων

ANOVA + Correlation

Σύγκριση κατανάλωσης καυσίμων μεταξύ διαφορετικών τύπων 
πλοίων (bulk carrier, tanker, container, Ro-Ro).

→ F-test: διαφορετικές διακυμάνσεις → t-test για κάθε ζεύγος

Εποχικότητα Αφίξεων Πλοίων

Histogram + Moving Average

Ανάλυση εποχικής κατανομής αφίξεων για βελτίωση 
προγραμματισμού προσωπικού και εξοπλισμού λιμένα.

→ Κινητός μέσος n=3 για εξομάλυνση μηνιαίων δεδομένων



09 | Ανάλυση Παλινδρόμησης — Πρόβλεψη Εσόδων 
Λιμένα
Βήμα-βήμα εφαρμογή με ναυτιλιακά δεδομένα
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1
Οργάνωση δεδομένων: Στήλη Α = TEU (ανεξάρτητη), Στήλη Β = Έσοδα €  
(εξαρτημένη)

2 Δεδομένα → Ανάλυση → Regression → ΟΚ

3 Input Y Range: $B$1:$B$13  |  Input X Range: $A$1:$A$13

4 ✓ Labels  |  ✓ Residuals  |  Output Range: επιλέξτε κελί

5 Ανάγνωση αποτελεσμάτων: R², Coefficients, p-values

Εξίσωση Παλινδρόμησης:  Έσοδα = 50.000 + 185 × TEU

Βασικά Αποτελέσματα

R² 0.87
87% ερμηνεία 
διακύμανσης

p-value (X) < 0.001 Στατ. σημαντικό

Intercept β₀ 50.000 Βασικά έσοδα (€)

Slope β₁ 185 € ανά TEU

Std Error 12.450 Διασπορά υπολοίπων

F-statistic 58.3 Σημαντικότητα μοντέλου

R² > 0.7 → Ισχυρό μοντέλο πρόβλεψης



Μεθοδολογία: Chain-of-Thought Ανάλυση
Πώς να σκέφτεστε βήμα-βήμα όταν κάνετε στατιστική ανάλυση
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1

Ορισμός Ερωτήματος

Τι θέλω να μάθω; Ποιες είναι οι μεταβλητές; Τι τύπου δεδομένα 
έχω; (ποσοτικά/κατηγορικά;)

2

Επιλογή Κατάλληλου Εργαλείου

1 μεταβλητή → Descriptive Stats / Histogram
2 ομάδες → t-Test (μέσοι) ή F-Test (διακυμάνσεις)
3+ ομάδες → ANOVA
Σχέση μεταβλητών → Correlation / Regression

3

Έλεγχος Προϋποθέσεων

Κανονικότητα κατανομής; Ισότητα διακυμάνσεων (F-Test πριν t-
Test); Ανεξαρτησία παρατηρήσεων;

4

Εκτέλεση Ανάλυσης στο Excel

Data → Data Analysis → επιλογή εργαλείου → Input/Output Range 
→ OK

5

Ερμηνεία Αποτελεσμάτων

p-value < 0.05 → απόρριψη H₀ (στατ. σημαντικό)
F > F_critical → απόρριψη H₀
R² → ποσοστό ερμηνείας (> 0.7 = ισχυρό μοντέλο)

6

Συμπέρασμα & Απόφαση

Επιστροφή στο αρχικό ερώτημα. Διατύπωση συμπεράσματος σε 
γλώσσα κατανοητή για τον κλάδο.



Πρακτική Άσκηση — Δεδομένα Λιμένα Πειραιά
Εφαρμόστε το Analysis ToolPak στα παρακάτω δεδομένα
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Δεδομένα: Λιμάνι Πειραιά (2023)

Μήνας TEU (χιλ.) Πλοία Έσοδα (€εκ.)

Ιαν 385 312 71.5

Φεβ 342 298 63.8

Μαρ 401 341 74.6

Απρ 428 365 79.8

Μαΐ 456 388 85.0

Ιουν 489 412 91.2

Ιουλ 512 435 95.4

Αυγ 498 418 92.8

Σεπ 445 378 82.9

Οκτ 421 358 78.5

Νοε 378 320 70.5

Δεκ 365 308 68.1

Ερωτήματα Προς Επίλυση

Α Descriptive Statistics για TEU.
Ποιος ο μέσος, η διάμεσος και η τυπική απόκλιση;

Β Histogram για τα Έσοδα.
Ποια κλάση εμφανίζεται πιο συχνά;

Γ Correlation μεταξύ TEU και Εσόδων.
Είναι ισχυρή η συσχέτιση (r > 0.9);

Δ Regression: Εσόδων ~ TEU.
Ποια η εξίσωση πρόβλεψης & το R²;

Ε Moving Average n=3 για TEU.
Πότε εμφανίζεται η εποχική αιχμή;

Χρησιμοποιήστε το Chain-of-Thought: Ορισμός ερωτήματος → Επιλογή εργαλείου → Ανάλυση → Ερμηνεία → Συμπέρασμα



Quick Reference — Ποιο Εργαλείο για Ποια Κατάσταση;
Οδηγός γρήγορης επιλογής ανάλυσης
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Ερώτηση / Κατάσταση Κατάλληλο Εργαλείο Βασική Έξοδος Ναυτιλιακό Παράδειγμα

Βασικές στατιστικές μιας 
μεταβλητής

Descriptive Statistics Mean, Std, Min, Max, 
Skewness

Στατιστικές TEU ανά μήνα

Κατανομή δεδομένων σε κλάσεις Histogram Πίνακας & γράφημα 
συχνοτήτων

Κατανομή χρόνων ελλιμενισμού

Σχέση/εξάρτηση 2 μεταβλητών Correlation Συντελεστής r (-1 έως +1) TEU vs Έσοδα λιμένα

Πρόβλεψη τιμής εξαρτ. 
μεταβλητής

Regression Εξίσωση Y=β₀+β₁X, R² Πρόβλεψη εσόδων από TEU

Σύγκριση διακυμάνσεων 2 ομάδων F-Test F, p-value, F_critical Σταθερότητα φορτίου 2 λιμανιών

Σύγκριση μέσων 2 ομάδων t-Test t Stat, p-value, df Χρόνος εκφόρτωσης: λιμ. Α vs Β

Σύγκριση μέσων 3+ ομάδων ANOVA F, p-value, F_critical Κατανάλωση καυσίμων 4 τύπων 
πλοίων

Εξομάλυνση/πρόβλεψη 
χρονοσειράς

Moving Average / Exp. 
Smoothing

Εξομαλυμένη σειρά Εποχικές αφίξεις πλοίων



Συχνά Λάθη & Χρήσιμες Συμβουλές
Τι να προσέχετε κατά τη χρήση του Analysis ToolPak

Excel Analysis ToolPak  |  Τμήμα Διαχείρισης Λιμένων & Ναυτιλίας  |  Εισαγωγικό Μάθημα Στατιστικής

Συχνά Λάθη

✕ Χρήση t-Test χωρίς πρώτα να ελέγξετε αν οι διακυμάνσεις είναι ίσες (F-
Test)

✕ Variable 1 στο F-Test με ΜΙΚΡΟΤΕΡΗ διακύμανση (πρέπει να είναι η 
μεγαλύτερη)

✕ Εφαρμογή ANOVA σε μόνο 2 ομάδες (χρησιμοποιείτε t-Test)

✕ Σύγχυση μονόπλευρου vs δίπλευρου ελέγχου (two-tail για ≠, one-tail 
για > ή <)

✕ Άγνοια προϋποθέσεων (κανονικότητα, ανεξαρτησία δεδομένων)

✕ Ερμηνεία υψηλής συσχέτισης ως αιτιότητα (correlation ≠ causation)

✕ Αγνόηση p-value — σημαντικό μόνο το F > F_critical

Χρήσιμες Συμβουλές

✓ Πάντα ξεκινάτε με Descriptive Statistics για να κατανοήσετε τα 
δεδομένα σας

✓ Ελέγξτε πρώτα τη διακύμανση (F-Test) πριν συγκρίνετε μέσους (t-Test)

✓ R² > 0.7 θεωρείται αποδεκτό μοντέλο παλινδρόμησης στις κοινωνικές 
επιστήμες

✓ Αποθηκεύετε τα αποτελέσματα σε νέο φύλλο εργασίας για καλύτερη 
οργάνωση

✓ Χρησιμοποιήστε γράφημα πριν την ανάλυση — εντοπίστε ακραίες τιμές 
(outliers)

✓ Στο ANOVA: αν H₀ απορρίπτεται, χρησιμοποιήστε t-Test για κάθε ζεύγος 
ομάδων

✓ Moving Average: μεγαλύτερο n → πιο ομαλή καμπύλη αλλά χάνετε 
πληροφορία



Chain-of-Thought: Παράδειγμα Πλήρους Ανάλυσης
Ερώτηση: Επηρεάζει ο αριθμός TEU τα έσοδα του λιμένα Πειραιά;

Excel Analysis ToolPak  |  Τμήμα Διαχείρισης Λιμένων & Ναυτιλίας  |  Εισαγωγικό Μάθημα Στατιστικής

1  Κατανόηση Ερωτήματος

Εξαρτημένη: Έσοδα (€)
Ανεξάρτητη: TEU (χιλ.)
→ Αναλύω γραμμική σχέση

2  Εξερεύνηση Δεδομένων

Descriptive Statistics → TEU: μέσος=427, 
std=51
Histogram → κανονική κατανομή
→ Δεδομένα κατάλληλα

3  Έλεγχος Συσχέτισης

Correlation → r = 0.98
→ Πολύ ισχυρή θετική συσχέτιση
→ Δικαιολογείται regression

4  Ανάλυση Παλινδρόμησης

Regression: Έσοδα = 50.000 + 185×TEU
R² = 0.91, p < 0.001
→ Εξαιρετική προσαρμογή

5  Συμπέρασμα

Για κάθε +1.000 TEU, τα έσοδα αυξάνονται 
κατά 185.000€. Μοντέλο εξηγεί 91% της 
διακύμανσης. Αξιόπιστη βάση για 
προγραμματισμό λιμένα.

6  Εφαρμογή στον Κλάδο

Πρόβλεψη: αν TEU → 520, τότε
Έσοδα = 50.000 + 185×520 = 146.200€
→ Στρατηγικός προγραμματισμός!



10 | Επόμενα Βήματα & Χρήσιμοι Πόροι
Πώς να συνεχίσετε την εκμάθηση

Excel Analysis ToolPak  |  Τμήμα Διαχείρισης Λιμένων & Ναυτιλίας  |  Εισαγωγικό Μάθημα Στατιστικής

Χρήσιμοι Πόροι

Microsoft 
Support: 

support.microsoft.com → Analysis ToolPak

Βιβλίο: «Statistics for Business» — Berenson & Levine

YouTube: Khan Academy: Statistics & Probability

Excel Campus: excelcampus.com → Data Analysis

Coursera: «Data Analysis and Visualization» — IBM

Επόμενα Βήματα

1 Εγκατάσταση & εξοικείωση με όλα τα εργαλεία (Lab 4)

2 Εξάσκηση με τα δεδομένα λιμένα Πειραιά (Slide 15)

3 Εκμάθηση Excel Pivot Tables για συνδυαστική ανάλυση

4 Εισαγωγή στο Power BI για οπτικοποίηση ναυτιλιακών 
δεδομένων

5 Advanced: Python/R για στατιστική ανάλυση μεγάλων 
δεδομένων

Βασικό Μήνυμα:

Το Analysis ToolPak μετατρέπει σύνθετες στατιστικές αναλύσεις σε απλές διαδικασίες κλικ. Στη Διαχείριση Λιμένων & Ναυτιλίας, αυτά τα 
εργαλεία σας επιτρέπουν να λαμβάνετε τεκμηριωμένες αποφάσεις βάσει δεδομένων.



Ευχαριστώ!

Excel Analysis ToolPak

Εισαγωγή & Εφαρμογές στη Διαχείριση Λιμένων & Ναυτιλίας

Εγκατάσταση: File → Options → Add-ins → Analysis ToolPak

19 εργαλεία ανάλυσης — Descriptive Stats, Histogram, Regression, ANOVA, t-Test...

Chain-of-Thought: Ερώτημα → Εργαλείο → Ανάλυση → Ερμηνεία → Συμπέρασμα

Εφαρμόσιμο σε πραγματικά ναυτιλιακά δεδομένα (TEU, έσοδα, χρόνοι, καύσιμα)

Τμήμα Διαχείρισης Λιμένων & Ναυτιλίας  |  Ακαδημαϊκό Έτος 2024–2025
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